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1. Introduction 

1.1 Definitions 

Contractor: Includes both General Contractors and Construction Manager at Risk (CMAR) 

1.2 Disclaimer 

It is the Consultant's responsibility to ensure that all schedule submittals during the design process 

comply with UMass Chan’s contract and specification requirements. The Consultant remains accountable 

for the overall proposed design, design schedule, and all applicable deliverables during the design and 

construction administration (CA) phase. 

Once the Contractor is engaged, it becomes the Contractor’s responsibility to ensure that schedule 

submittals comply with UMass Chan’s contract and specification requirements. The Contractor remains 

accountable for the project scope of work, means and methods, and the planned sequence of 

construction activities. 

UMass Chan makes no representations or warranties, express or implied, regarding the accuracy, 

reliability, or completeness of the toolkit or the information contained therein. The Owner assumes no 

liability or responsibility for any damages, losses, or claims arising from the use, misuse, or inability to 

use the toolkit, including any improper or incorrect application. 

The Owner reserves the right to update, amend, or remove information contained in the toolkit at any 

time without prior notice. Users should consult the Owner’s website for the most current version of the 

toolkit. 

1.3 Contract Requirements for Schedules and Submittals 

The Owner’s Schedule Toolkit is an extension of the Project Schedule Specification, as outlined in the 

General Conditions Section 6 and General Requirements Section 13200. It is intended to provide 

Contractors with guidance and support in meeting all schedule specification requirements. 

The toolkit includes this document, a Primavera schedule (.XML) file, and Primavera P6 EPPM schedule 

layout (.PLF) files. For projects utilizing OPC, Contractors should request the required views directly from 

the Owner Project Manager and Project Controls. 

The toolkit is designed to: 

• Establish a schedule backbone that aligns with software requirements. 

• Reduce the administrative burden of configuring the schedule platform. 

• Provide standard reports, calendars, activity IDs, and layouts that meet Owner requirements. 

1.4 Schedule Software Requirements 

The table below establishes the approved scheduling software based on the project’s Owner Cost and 

outlines the schedule types required for submission. 
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Construction Cost 
Range 

Scheduling Platform Required Schedule Types 

Design Schedules 

Microsoft Project, 
Primavera P6, Oracle 
OPC, Other (if approved 
by the Owner in 
advance) 

-Not applicable 

Under $1M 

Microsoft Project, 
Primavera P6 or Oracle 
OPC  

- Baseline Schedule  
- Monthly Progress Schedule Updates 
(Narrative not required for construction 
projects under $500K) 
- Lookahead Schedules  
- Recovery Schedules  
- Proposal Schedules  
- Delay Notices  
- Time Impact Analysis  

Over $1M 
Primavera P6 or Oracle 
OPC  

- Baseline Schedule  
- Monthly Progress Schedule Updates  
- Lookahead Schedules  
- Recovery Schedules  
- Proposal Schedules  
- Delay Notices  
- Time Impact Analysis  

 

1.5 Roles and Responsibilities 

This Schedule Toolkit provides standards and guidelines for both Design and Construction schedules. 

The Consultant and Contractor are expected to work collaboratively to prepare, update, and maintain 

schedules in accordance with Owner requirements. The table below defines the roles and responsibilities 

of each party. 

Entity 
Design Schedule & 
Monthly Updates 

Construction Schedule 
& Monthly Updates 

UMass Chan Medical School Review & Approve Review & Approve 

Design Team Develop Review 

Contractor N/A Develop 
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2. Schedule Software Settings 

2.1 Oracle Primavera Settings 

This template was created using the schedule settings found under Tools > Schedule > Options. 

Contractors must use these same settings for all schedule submissions. Figure 1 shows P6 EPPM 

Settings. Figure 2 shows Oracle OPC Settings.  

NOTE: For schedules that are created in MS Project, refer to Section 2.2 below for further ways to mimic 

these settings. 

 
Figure 1: P6 Schedule Setting 
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Figure 2: OPC Schedule Settings 

 
2.2 MS Project – Recommended Settings 

When schedules are developed in Microsoft Project, users must take additional steps to configure the 

system so that outputs are consistent with Primavera-based schedules.  MS Project and Primavera differ 

in how they handle calendars, task types, constraints, relationships, and progress measurement. To 

minimize these differences, schedules created in MS Project should be configured with the following 

considerations: 

• Calendar and Time Units – Set hours per day, week, and month to match Primavera defaults (8 

hours/day, 40 hours/week, 20 days/month). Align work hours and non-workdays with the approved 

project calendar. 

• Task Types and Durations – Default to Fixed Duration tasks and turn off “Effort Driven” to prevent 

unintended recalculations when resources are added. 

• Relationships and Lags – Use Finish-to-Start as the default dependency and apply lags in 

working time only.  Avoid “elapsed” durations unless intentional. 
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• Constraints – Apply constraints sparingly, using equivalents (e.g., “Must Finish On” for 

Mandatory Finish). Ensure “Tasks will always honor constraint dates” is enabled. 

• Progress Measurement – Use Physical % Complete to align with Primavera’s flexibility for 

earned value and performance tracking. 

• Critical Path Settings – Define critical tasks as those with Total Float ≤ 0 days, consistent with 

Primavera’s default critical path method. 

These settings help ensure that MS Project schedules mirror Primavera logic as closely as possible, 

allowing for consistency in reporting, review, and compliance with the Owner’s schedule specification. 

2.3 Calendars 

Primavera uses activity calendar assignments to define allowable work periods. To support consistency, 

the Owner has developed a set of standard calendars that reflect the work periods typically encountered 

on Owner projects. These calendars align with the Owner’s standard specifications and account for 

common work restrictions. 

The following standard calendars have been created within the OPC software. Non-shaded calendars 

represent Default/Global options, while shaded calendars represent UMass-specific calendars. 

 
Figure 3: (Example) OPC Template Calendar View 

NOTE: Any request to use a calendar outside of the standard set must be submitted in advance and 

approved by the Owner Project Manager and Project Controls. 

2.4 Holidays 

The template schedule has been updated to include Massachusetts state holidays through 2030. Official 

holiday information can be found at: https://www.sec.state.ma.us/divisions/cis/holiday-info.htm  

Holiday 2025 2026 2027 2028 2029 2030 

https://www.sec.state.ma.us/divisions/cis/holiday-info.htm
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New Year’s 

Day  
Jan. 1, Wed. Jan. 1, Thur. Jan. 1, Fri. Jan. 1, Sat. Jan. 1, Mon. Jan. 1, Tue. 

MLK Jr. Day  
Jan. 20, 

Mon. 
Jan. 19, 

Mon. 
Jan. 18, 

Mon. 
Jan. 17, 

Mon. 
Jan. 15, 

Mon. 
Jan. 21, 

Mon. 

Patriots’ Day  Apr. 21, Mon. Apr. 20, Mon. Apr. 19, Mon. Apr. 17, Mon. Apr. 16, Mon. Apr. 15, Mon. 

Memorial Day  
May 26, 

Mon. 
May 25, 

Mon. 
May 31, 

Mon. 
May 29, 

Mon. 
May 28, 

Mon. 
May 27, 

Mon. 

Juneteenth  Jun 19, Thu. Jun 19, Fri. Jun 19, Sat. Jun 19, Mon. Jun 19, Tue. Jun 19, Wed. 

Independence 

Day  
Jul. 4, Fri. Jul. 4, Sat. Jul. 4, Sun. Jul. 4, Tue. Jul. 4, Wed. Jul. 4, Thu. 

Labor Day  Sep. 1, Mon. Sep. 7, Mon. Sep. 6, Mon. Sep. 4, Mon. Sep. 3, Mon. Sep. 2, Mon. 

Columbus Day  
Oct. 12, 

Mon. 
Oct. 9, Mon. Oct. 11, Mon. Oct. 9, Mon. Oct. 8, Mon. 

Oct. 14, 
Mon. 

Veterans’ Day  Nov. 11, Tue. 
Nov. 11, 

Wed. 
Nov. 11, Thu. Nov. 11, Sat. Nov. 11, Sun. 

Nov. 11, 
Mon. 

Thanksgiving  Nov. 27, Thu. Nov. 26, Thu. Nov. 25, Thu. Nov. 23, Thu. Nov. 22, Thu. Nov. 28, Thu. 

Christmas Day 
Dec. 25, 

Thu. 
Dec. 25, Fri. Dec. 25, Sat. 

Dec. 25, 
Mon. 

Dec. 25, Tue. 
Dec. 25, 

Wed. 

Figure 5: MA Holidays Through 2030 

NOTE: Commencement Week is designated as a non-work period. The Consultant and Contractor shall 

be responsible for confirming the exact dates with the Owner Project Manager and Project Controls. Once 

confirmed, these dates must be incorporated into the project schedule as non-workdays. 

2.5 Reporting Milestones  

For each project type, specific Reporting Milestones must be created and linked to the relevant activities. 

These milestones use designated Activity IDs that are required for UMass Chan Medical School reporting. 

They are intended solely for Owner reporting and do not constitute Contractual Milestones unless 

explicitly identified in the contract. 

A listing of the minimum milestone requirements for design, along with full project schedules, can be 

found in the Reporting Milestones sections within this toolkit. 

2.6 Monthly Schedule Updates 

A monthly schedule update must be submitted to the Owner within ten (10) calendar days of the beginning 

of each month. Each update shall carry a data date of the first (1st) of the month and include progress 

up to that date. 

All schedule submissions are to be made via UMass Chan’s PMIS to the UMass Chan Project Manager 

and Project Controls and must include the following attachments: 

• Schedule file in .XML format (for P6 and MS Project) 

• Schedule Narrative in PDF format 
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• Required Layouts in PDF format (refer to Section 2.7 for specific layouts. Each layout must be 

submitted as a separate PDF) 

Upon submission in PMWeb, schedules will be routed through the predefined workflow for UMass Chan 

Medical School Project Team review and approval. 

2.7 Standardized Schedule Layouts 

2.7.1 Primavera P6 Settings 

Each schedule submission must include standardized schedule reports in PDF format, prepared in full 

compliance with the schedule specifications. To support this requirement, the Owner has provided several 

Primavera Layout (.PLF) files for use by Consultants and Contractors. These layouts must be 

downloaded, imported, and applied when generating reports. 

Required Layouts 

• All Activities (General Schedule Layout) 

• Critical Path / Longest Path Layout 

• Near Critical (less than 10 days of float) 

• 3-Week Lookahead Layout 

• Recent Progress Layout (with variance to dates and total float of previous update) 

• Baseline Variance Layout 

Importing Layout Files 

• Import each layout separately: View → Layouts → Open → Import 

• After import, select the desired layout: View → Layouts → Open 

Required Information in All Schedule Reports 

Unless otherwise specified, all schedule reports must include the following: 

• Schedule Information – Columns View 

o Current Schedule: Activity ID, Activity Name, Start, Finish, Total Float 

o Baseline Schedule: Baseline Start, Baseline Finish, Baseline Total Float, Variance of 

Baseline Finish 

o Note: Start and Finish dates must use Primavera “Start” and “Finish” fields. 

• Schedule Information – Bars View 

o Bar styles, colors, target information, and calendar formatting. 

• Grouping and Sorting 

o Appropriate grouping and sorting must be applied to ensure clarity. 
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• Data Filtering 

o Filters should be applied as necessary to support the purpose of the report. 

• Administrative Report Information 

o Headers and footers, report titles, page breaks, page numbers, and all other required 

formatting. 

2.7.2 Primavera OPC Settings 

Each schedule submission must include standardized schedule reports in PDF format, prepared in full 

compliance with the schedule specifications. To support this requirement, the Owner has developed 

Primavera OPC Views for use by Consultants and Contractors. These Views must be requested from the 

Owner Project Manager and Project Controls and applied when generating reports. 

Required Views 

• All Activities (General Schedule View) 

• Critical Path / Longest Path View 

• Near Critical (less than 10 days of float) 

• 3-Week Lookahead Layout 

• Recent Progress View (with variance to previous update) 

• Baseline Variance View 

Applying Views in OPC 

• Request the standardized Views from the Owner Project Manager and Project Controls. 

• Import or load each View into the OPC workspace as directed. 

• Apply the desired View when preparing schedule reports. 

Required Information in All Schedule Reports 

Unless otherwise specified, all OPC-generated schedule reports must include the following: 

• Schedule Information – Table View 

o Current Schedule: Activity ID, Activity Name, Start, Finish, Total Float 

o Baseline Schedule: Baseline Start, Baseline Finish, Baseline Total Float, Variance of 

Baseline Finish 

o Note: Start and Finish dates must use the OPC “Start” and “Finish” fields. 

• Schedule Information – Gantt/Chart View 

o Bar styles, colors, target information, and calendar formatting consistent with Owner 

standards. 
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• Grouping and Sorting 

o Appropriate grouping and sorting must be applied to ensure clarity. 

• Data Filtering 

o Filters should be applied as necessary to support the purpose of the report. 

• Administrative Report Information 

o Headers and footers, report titles, page breaks, page numbers, and all other required 

formatting. 

2.7.3 MS Project Settings 

Each schedule submission must include standardized schedule reports in PDF format, prepared in full 

compliance with the schedule specifications. To support this requirement, the Owner has defined 

standardized Views, Tables, Filters, and Groupings for use by Consultants and Contractors. These 

configurations must be downloaded or requested from the Owner Project Manager and Project Controls, 

then applied when generating reports. 

Required Views/Reports 

• All Activities (General Schedule View) 

• Critical Path / Longest Path View 

• Near Critical (less than 10 days of float) 

• 3-Week Lookahead Layout 

• Recent Progress View (with variance to previous update) 

• Baseline Variance View 

Applying Views in Microsoft Project 

• Import or create the required Views, Tables, and Filters as directed by the Owner Project Manager 

and Project Controls. 

• Select the appropriate View from the View tab. 

• Apply the required Table, Filter, and Grouping options to format the report. 

• Export the formatted output to PDF for submission. 

Required Information in All Schedule Reports 

Unless otherwise specified, all Microsoft Project–generated reports must include the following: 

• Schedule Information – Table (Columns) View 

o Current Schedule: Task ID, Task Name, Start, Finish, Total Slack 

o Baseline Schedule: Baseline Start, Baseline Finish, Baseline Total Slack, Variance of 

Baseline Finish 



 
Schedule Toolkit | All Project Types  13 

o Note: Start and Finish dates must use the “Start” and “Finish” fields, not Actual Start/Finish 

unless specifically instructed. 

• Schedule Information – Gantt Chart View 

o Bar styles, colors, target information, and calendar formatting consistent with Owner 

standards. 

• Grouping and Sorting 

o Apply grouping and sorting rules for clarity (e.g., by WBS, Phase, Discipline, or Contractor-

provided coding). 

• Data Filtering 

o Apply filters as necessary to meet the intent of the report (e.g., Critical Path, Near Critical, 

or Lookahead). 

• Administrative Report Information 

o Headers and footers, report titles, page breaks, page numbers, and all other required 

formatting. 

3. Project Schedules 

3.1 Purpose of a Design Schedule 

The Owner’s Design Schedule Toolkit is an extension of the Project Schedule Specification and is 

intended to provide Consultants with support and guidance in meeting the requirements of the schedule 

specification.  

The objective is to utilize the design schedule information for planning, controlling, and reporting design 

and engineering activities. This narrative provides step-by-step instructions for creating the design 

schedule, which will be used to estimate and manage the duration of the design portion of the project. 

The intent to use a design schedule is to: 

• To help the Owner adjust to changes during design. 

• It can be used to prepare proactive recovery/acceleration plans during changes/delays during the 

design phase.  

• Develop a tracking and reporting process that helps the Owner monitor schedule status and to 

initiate corrective action (if required). 

• Produce reports to help the Owner’s management team evaluate the capital program. 

• Improve logistics. 

• Provides a schedule backbone that supports the software requirements. 

• Minimizes the administrative burden of adjusting the schedule platform to meet these 

requirements. 
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• Provide standard reports, calendars, activity IDs, and layouts that meet the Owner’s requirements. 

The Consultant is requested to submit a Design Schedule to track the project’s design phase effort. The 

schedule should track work as outlined in the Work Order and be submitted simultaneously with the Work 

Order. This schedule will represent the Consultant’s Baseline Schedule.  

3.2 Design Reporting Milestones 

The Contract requires the following Reporting Milestones to be included with all schedule submissions. 

All reporting milestones should be assigned the 7‐day calendar with no holidays provided. These 

Reporting Milestones are used solely for UMass Chan Medical School Reporting purposes, and they do 

not serve as “Contractual Milestones” unless they are applicable to the contract. 

As noted in the schedule specification, the activity ID and activity name must match what has been 

provided in the specification (as listed below). In addition, the activity ID and activity name must not 

change through the design phase. 

The Consultant should inform UMass Chan Medical School if some of these reporting milestones are not 

applicable to their project or require utilizing different milestones. 

 

Figure 6: UMC Design Milestones 

3.3 Schedule WBS 

Each schedule submission must follow the Work Breakdown Structure (WBS) provided in this toolkit. The 

standard WBS is included in the schedule toolkit .XML file and serves as the primary framework for 

schedule organization and grouping. Additional WBS levels may be added at the Consultant’s discretion 

but require prior approval from the Owner and Project Manager.  

  

Figure 7: Project Schedule WBS Example 
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3.3.1 Summary Activities 

The Consultant must set up Summary Level Activities to align with the Work Order. Requirements include: 

• Durations of Summary Level Activities must match those in the Work Order. 

• Summary Level Activities must be cost-loaded, with costs derived from the level of effort in the 

Work Order. 

• Activity durations should not be shorter than one (1) week. 

• Lower-level activities must roll up to their respective Summary Level Activities. 

• Summary Level Activities must roll up to the milestones defined in this toolkit. 

3.3.2 Activities Settings 

The WBS will remain the primary method of schedule organization and grouping. Activity codes may also 

be added at the vendor’s discretion; however: 

• All activity codes must be maintained at the Project Level. 

• Global activity codes will not be accepted. 

3.4 Schedule Updates 

3.4.1 Update Cycle 

The Consultant must submit a monthly schedule update by the 10th of each month. Each update shall 

use a Data Date of the first (1st) of the month. All updates must comply with the requirements outlined 

within this Schedule Toolkit 

3.4.2 Performance Measurement 

Activities must accurately reflect the actual progress achieved during the reporting period. Progress shall 

be updated using either the Estimated Finish Date or Remaining Duration. 

 

3.4.3 Schedule Changes 

When a new Work Order or Work Order Amendment is issued and approved, the Consultant must update 

the schedule accordingly and document any changes in the Narrative submitted to UMass Chan Medical 

School. 

• If changes affect milestone dates and require a revision to the Baseline schedule, the Consultant 

must notify UMass Chan Medical School and obtain approval prior to implementing Baseline 

changes. 

3.5 Schedule Narrative 
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As outlined in the Schedule Specification and Consultant Contracts, all schedule submissions must be 

accompanied by a detailed written narrative. The Consultant’s narrative shall include, at a minimum, the 

following: 

3.5.1 Executive Summary 

• General statement of whether the project is on schedule, ahead, or behind. 

• Key indicators: progress vs. plan, overall percent complete, and major milestone status. 

3.5.2 Milestone Chart 

• Show original and modified Contractual (or approved Baseline) dates. 

• Include current and previous forecasted dates for all interim and Contractual milestones. 

• Provide variance columns comparing: 

o Current vs. Contractual 

o Current vs. Modified Contractual 

o Current vs. Previous 

3.5.3 Assumptions 

• List any assumptions made in preparing the update. 

• Progress Summary 

• Describe work completed during the reporting period. 

3.5.4 Outstanding Decisions 

• Identify responses required for key decisions. 

• Indicate which items are critical or near critical (based on total float). 

• Provide the date by which a response is needed. 

3.5.5 Changes Since Last Update 

• List and explain all changes from the previous update. 

• List of added and deleted activities 

3.5.6 Planned Percent Complete 

• Report the current planned percent complete. 

4. Construction Schedules 

4.1 Purpose of a Construction Schedule 
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The Owner’s Construction Schedule Toolkit is an extension of the Project Schedule Specification and is 

intended to provide Contractors with support and guidance in meeting the requirements of the schedule 

specification. The toolkit is comprised of this document, a Primavera schedule (.XML) file, and Primavera 

schedule layout (.PLF) files. 

For schedules developed in Microsoft Project, the Owner provides equivalent standardized Views, 

Tables, Filters, and Groupings. These configurations are designed to replicate the requirements of the 

Primavera layouts and should be applied when generating schedule reports. Contractors are responsible 

for requesting these configurations from the Owner Project Manager and Project Controls and ensure 

they are incorporated into all schedule submittals. 

The objective is to use the construction schedule information for planning, sequencing, controlling, and 

reporting Construction Activities. This narrative provides step-by-step instructions for creating the 

construction schedule, which will be used to estimate, monitor, and manage the duration and sequencing 

of the construction portion of the project. 

The intent of using a construction schedule is to: 

• Assist the Owner in anticipating and adapting to changes during the construction phase. 

• Provide a tool for developing proactive recovery and acceleration plans in response to delays, 

disruptions, or changed conditions. 

• Establish a process for tracking and reporting construction progress, enabling the Owner to 

monitor schedule status and require corrective action if necessary. 

• Produce reports that support the Owner’s management team in evaluating project and program-

level performance. 

• Improve coordination among the Contractor, subcontractors, suppliers, and Owner 

representatives. 

• Define and communicate the planned sequence of work, including critical path activities and 

interfaces with other trades or contracts. 

• Support planning for field logistics, site access, material deliveries, and resource allocation. 

• Provide a resource- and cost-loading framework to monitor productivity and support earned value 

analysis (if required by the Contract). 

• Supply standard reports, calendars, activity IDs, and layouts that align with the Owner’s 

requirements. 

The Contractor is required to submit a Construction Schedule that fully represents the project scope of 

work as defined in the Contract Documents. The schedule must reflect the Contractor’s means and 

methods, subcontractor coordination, and planned sequence of work. The Baseline Construction 

Schedule must be submitted for approval prior to the commencement of construction activities.  

4.2 Baseline Schedule  
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The Contractor is required to submit the Initial Baseline Schedule within fourteen (14) calendar days from 

Notice to Proceed (NTP). The Baseline Schedule must be submitted through UMass Chan’s PMIS and 

shall reflect the full scope of work awarded to the Contractor. Once accepted by UMass Chan Medical 

School, the Baseline Schedule will be designated as the Baseline Schedule of Record and will serve as 

the measurement tool for tracking and comparing all project progress. 

To monitor schedule variance over time, all schedule reports must include comparisons to both the 

previous update and the current accepted Baseline Schedule. For this purpose: 

• In Primavera P6 and OPC: 

o The previous month’s schedule file shall be assigned as the Primary Baseline. 

o The current accepted Baseline Schedule shall be assigned as the User Baseline – 

Primary. 

o In Primavera, these assignments can be made under Project → Assign Baseline. 

• In Microsoft Project: 

o The previous month’s schedule should be saved as Baseline 1 (or next available interim 

baseline). 

o The current accepted Baseline Schedule should be saved as the Project Baseline 

(Baseline 0). 

o These assignments are made under Project → Set Baseline, where the user can select 

either the full project or specific tasks. 

Both Primavera and MS Project schedules must be configured so that monthly reports show variances 

against the prior update and the Baseline Schedule of Record. 

4.3 Construction Reporting Milestones 

The Contract requires the following Reporting Milestones to be included with all schedule submissions. 

All Reporting Milestones shall be assigned to a 7-day calendar with no holidays. These milestones are 

used solely for UMass Chan Medical School reporting purposes and do not constitute “Contractual 

Milestones” unless specifically identified as such in the Contract. 

As stated in the schedule specification, the Activity ID and Activity Name must match exactly as 

provided in the specification (see list below). These identifiers shall remain unchanged for the duration of 

the project. 

If certain Reporting Milestones are not applicable to the project, or if alternative milestones are required, 

the Contractor shall notify UMass Chan Medical School for review and approval. 
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Figure 7: UMC Project Milestones 

 

4.4 Schedule WBS 

Each schedule submission must follow the Work Breakdown Structure (WBS) provided below, which is 

also included in the Schedule Toolkit .XML file. The WBS structure shown serves as the primary 

framework for organizing and grouping schedule activities. Contractors may add further WBS detail at 

their discretion to support project-specific needs, provided the required structure is maintained. 

NOTE: The WBS levels provided by the Owner must not be altered or renamed. Any additional WBS 

detail added by the Contractor shall be supplemental and subordinate to the required structure. 
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Figure 8: Construction Schedule WBS 

4.4.1 Summary Activities 

The Contractor is required to develop Summary Level Activities (Level of Effort) derived from the project’s 

detailed activities. These Summary Activities shall align with the line items in the approved Schedule of 

Values (SOV) and will roll up to the designated Reporting Milestones.  These activities will enable the 

UMass Chan team to develop project cash flows and track the project's financial progress over time. 

4.4.2 Activities Settings 

Individual Schedule Activity durations shall not exceed eighteen (18) calendar days. This limit ensures 

that activities are developed at a level of detail that supports effective monitoring, accurate progress 

measurement, and early identification of potential delays. Shorter activity durations improve the reliability 

of schedule updates, provide clearer visibility into work progress, and enable timely corrective actions 

when issues arise. All activities must be organized to roll up appropriately to the Summary Level Activities. 

Best Practice Note: This requirement is consistent with industry standards (e.g., AACE International, 

CMAA, NAVFAC), which generally recommend limiting activity durations to 10–20 workdays. This range 

is considered optimal for balancing schedule manageability with meaningful progress tracking. 

4.5 Schedule Updates 

4.5.1 Update Cycle 

The Contractor is required to submit a monthly schedule update for work performed, no later than the 

10th day of each month. Each submission shall use a Data Date of the 1st day of the month. All updates 

must be prepared in accordance with this Schedule Toolkit. 

4.5.2 Performance Measurement  

The Owner requires that all schedule activities use Physical % Complete as the performance 

measurement method.  The physical % complete is a measure of the actual physical work completed on 

a specific task, rather than the amount of time or duration that has passed.  This setting ensures that 

progress reflects the actual work performed during each monthly update period. 

• Primavera P6: Set the % Complete Type field to Physical for all activities. 
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• Primavera OPC: Configure each activity’s Progress Measurement setting to Physical % 

Complete. 

• Microsoft Project: Assign the project’s Earned Value Method to Physical % Complete (available 

in Task Information → Advanced tab). 

Physical % Complete values shall be reviewed and updated in each reporting period. Reported progress 

must accurately represent the work accomplished, not just the passage of time or resource expenditure. 

4.6 Schedule Narrative 

As required by General Requirements, Section 13200 of the schedule specification, all schedule 

submissions shall be accompanied by a detailed written narrative. The purpose of the narrative is to 

clearly explain the logic, assumptions, progress, variances, and changes reflected in the schedule update 

so that the Owner can evaluate both current status and future impacts. At a minimum, the Contractor’s 

narrative shall address the following: 

• Milestone Chart 

o Provide a milestone chart that includes the original and any modified Contractual (or 

approved baseline) dates, along with the current and previous forecast dates for all interim 

and Contractual milestones. 

o Include variance columns for: 

▪ Current vs. Contractual 

▪ Current vs. Modified Contractual 

▪ Current vs. Previous Update 

• Executive Summary 

o Provide a high-level summary highlighting key progress, issues, and overall schedule 

status. 

• Longest Path 

o Describe the scope of work and major sequences for all activities on the Longest Path. 

Explain any changes since the previous update. 

o Compare early and late dates for activities on the Longest Path. Provide explanations for 

changes to the top three longest paths. 

o Describe the Contractor’s plan, approach, methodologies, and resources for completing 

the work on the top three longest paths. 

• Progress 

o Summarize work progress during the current update period. 

o Provide a look-ahead summary for the forthcoming update period. 
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o Identify and explain all changes to the schedule during the update period, including 

additions, deletions, or modifications to milestones, activities, logic relationships, codes, 

WBS, etc. 

• Delays and Notices 

o Reference any Notices of Delay issued during the period. 

o Provide a detailed discussion of added activities that reflect the delay and explain how the 

delay affects the project’s critical path. 

• Specification Compliance 

o Identify and explain all areas where specification requirements are not being addressed 

or followed. 

• Key Decisions 

o Provide a list of responses required for key decisions. 

o Identify items that are critical or near critical (based on project total float), along with the 

required response dates. 

• Recovery / Early Completion 

o Provide an explanation of possible measures to achieve early completion or to recover 

schedule slippage. 

• Calendars 

o List all activity calendars being used. 

o Explain the use of shift work. 

o Identify and explain any changes to calendar usage since the previous submission. 

• Out-of-Sequence Logic 

o Identify and explain all instances of out-of-sequence activity logic. 

• Planned Percent Complete Update 

o Provide an update of Planned Percent Complete values. 

4.7 Change Management 

4.7.1 Schedule Changes 

When Bulletins are issued and approved, the Contractor shall update the schedule to reflect the 

associated changes in scope, sequencing, or duration of activities. The revised schedule must be 

submitted as part of the next monthly schedule update through PMWeb for UMass Chan Medical School 

review and approval. 

All schedule changes shall: 

• Clearly identify the activities impacted by the Bulletin. 
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• Incorporate any new activities, logic ties, or resources required to execute the Bulletin work. 

• Include adjustments to milestones, interim dates, or critical path activities if applicable. 

• Maintain traceability by documenting the reason for each change in the schedule narrative. 

• Provide variance reporting that compares the revised schedule to both the previous update and 

the current Baseline Schedule of Record. 

The Contractor is responsible for ensuring that all approved Bulletins are integrated promptly into the 

project schedule, so that UMass Chan Medical School has an accurate and timely representation of the 

project's status and forecasted completion. A WBS shall be set up to track the issuance data and approval 

process of the Bulletin, and the corresponding activities shall be integrated into the overall project 

schedule.  A naming convention and activity code should be added to each task associated with a Bulletin 

to ensure ease of review, tracking, and reporting.   

4.7.2 Pending Changes / Fragnets 

When a change is under review but not yet approved, the Contractor shall prepare a fragnet (a group of 

activities that represents the proposed change) and incorporate it into the project schedule for analysis. 

Pending changes must be clearly identified and distinguished from approved work. These fragnets may 

be submitted as “what-if” scenarios or time impact studies to demonstrate the potential effect of the 

change on Contract milestones and the project’s critical path. Pending changes should not alter the 

official schedule of record until formal approval is received. 

4.7.3 Time Impact Analysis (TIA) 

For any change, delay, or event that may affect Contract milestones, the Contractor shall prepare and 

submit a Time Impact Analysis (TIA). TIAs must be based on the accepted schedule of record in place at 

the time the event occurred. Each TIA shall include: 

• A fragnet illustrating the additional or revised work scope, logic ties, and durations. 

• Identification of the activities impacted, including changes to critical and near-critical paths. 

• An updated forecast of milestone completion dates. 

• Supporting narrative that explains assumptions, methodology, and conclusions. 

TIAs shall be submitted promptly for UMass Chan Medical School review and approval in accordance 

with the Contract requirements for change management and delay claims. 

4.7.4 Change Log / Documentation 

The Contractor shall maintain a change log that records all schedule modifications, whether due to 

approved Bulletins, Change Orders, or other directives. Each entry must include a reference to the 

change document, the date incorporated, and a description of the activities affected. The change log shall 

be submitted as part of each monthly schedule update and cross-referenced in the narrative. The log 

must clearly identify whether the change is approved, pending, or withdrawn, ensuring full transparency 

of schedule revisions throughout the project. 
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4.7.5 Baseline Revisions / Re-baselining 

In cases where significant scope changes, major delays, or contract modifications occur, the Contractor 

may be required to develop and submit a Revised Baseline Schedule. The Revised Baseline shall reflect 

the updated project scope and sequencing and will serve as the new Baseline Schedule of Record once 

accepted by UMass Chan Medical School. Re-baselining requires prior approval from the Owner, and 

the Contractor’s request must include justification, supporting documentation, and a clear explanation of 

why a re-baseline is necessary. 

 


